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‘ﬁ' Quantitative Imaging Tutorial

« Quantitative Imaging techniques can be
used to give radiologists complementary
information for interpreting images

* The hands-on aspect of the course is
intended to give clinical researchers a
practical experience on the latest
methods developed in medical
research
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Quantltatlve Imaging Tutorial

This tutorial is built upon a series of
examples of quantitative imaging analysis:

- Morphology: volumetric changes in
brain and breast tumors

- Function: metabolic activity in squamous
cell carcinoma
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Tutorial Materials

®

 Software: 3D Slicer

¥ | | Quantitativelmaging_Tuesday_Dec2
v || dataset1l_MR-Head .
MRHead_Scene.mrb ° Datas.ets_' .
v [ dataset2_ChangeTracker Quantitativelmaging_Tuesday Dec?2

ChangeTrackerScene.mrb
v | | dataset3_PETCT
PET_CT_post-treatment.mrb
PET_CT_pre-treatment.mrb
» 8 PET1
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‘ﬁ' Tutorial Overview

Part 1: Introduction to 3D Slicer

Part 2: Basics of data loading and 3D interactive
visualization

Part 3. Measurement of volumetric changes
- large volumetric change: breast tumor case
- small volumetric change: meningioma case
Part 4. Measurement of metabolic activity
- squamous cell carcinoma case
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®

3D Slicer

~
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& 30 Slicer ...

3D Slicer is a freely available open-
source platform for segmentation,
registration and 3D visualization of
medical imaging data.

3D Slicer is a multi-institutional effort
supported by the National Institute of
Health.
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‘ﬁb 3DSlicer History

Image Courtesy of the CSAIL, MIT

1997: Slicer started as a
research project
between the Surgical
Planning Lab (Harvard)
and the CSAIL (MIT)
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®

3DSlicer History

Powerful processing. l Streamlined interface. [ Extensible platform.

g

1997: Slicer started as a
research project
between the Surgical
Planning Lab (Harvard)
and the CSAIL (MIT)

2014 Multi-institution
effort to share the latest
advances in image
analysis with clinicians
and scientists
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A multi-institution: NA-MIC, NAC, NCIGT

National Alliance for Medical Image Computing
A National Center for Biomedical Computing
Funded under the NIH Roadmap Initiative

Neuroimage Analysis Center

“understanding the human brain through imaging*

[Search}

About the NAC

» Ovenview
NA-MIC Wiki * Organization

» Research Cores
General * Collaborations
»Overview
»Organization Resources

RSNA 2014
»Contact Us 100th Annual Meeting of * Our Publications.
the Radiological Society of + Downloads

Center Components North America, will be * Training
s, | R
»Engineering Place, Chicago. Sli * Contact Us

» Driving Biological Projects
» Coltaboration Grants

Resources
»Publication DB
»Image Gallery
»Downloads
»Service

» Training

» Dissemination
»Events

»Links

hands-on courses also will
be presented at the
meeting.

O Read more..

O NEWS ARCHIVE

genetic markers brain eadophenot yoe features

Joint Modeling of Imaging and Genetics. Read more...

19 Photos

The National Alliance for Medical Image Computing (NA-MIC) is a multi-

institutional, interdisciplinary team of computer scientists, software engineers,

and medical if i who develop { tools for the analysis and

visualization ut med ical image data The purpose of the Center is to provide the
of

and open- soum (scﬂnologles, and men oversee the training and dissemination
of these tools to the medical research community.

NA-MIC is a national research center sug
the NIBIB NIH HHS Roadmap for Medica

A Feature-based Developmental Model of the Infant Brain In Structural MRI

'hpﬁhﬂmﬂl A) for the 20 most significant age-related features over 10 age
mdmmdrﬂ-)h-ﬂ.ulmdnu
(l 8) and (1,19) represent symmetric white matter pattemns
mmm-ﬂmwmmm
and occurring exclusively in early life.

s Pl RON KiKiNis, M.D. el

"The Neuroimage Analysis Center (NAC) deveiops image processing and analysis
techniques for basic and clinical neurosciences. The NAC research approach

Qgﬂ‘ ‘J(rq,
G.ﬁ; National Center for Image Guided Therapy e ooy
% %
KY
CurpEo’ ‘f
NceTwiki | Advanced Multimodality Image Guided Operating (AMIGO) Suite
About Us
e e | The Advanced Multimodal Image-Guided Operating (AMIGO) suite is a dlinical translational test-bed for
» Collaborations research of the National Center for Image-Guided Therapy (NCIGT) at Brigham and Women's Hospital
PPacgls (BWH) and Harvard Medical School. NCIGT and AMIGO are funded under the Biomedical Technology
Resources Resource Centers program of the National Institute of Biomedical Imaging and Bioengineering. A unique
»AMIGO resource for Image-Guided therapy, AMIGO represents and encourages multidisciplinary cooperation and

»our
Pibleations
» Downloads.

Trining &
Bisanusaton

» IGT Worksho
o

collaboration among teams of surgeons, interventional radiologists, imaging physicists, computer
scientists, biomedical engineers, nurses, and technologists to achieve the common goal of delivering the
safest and the most effective state-of-the-art therapy to patients i a technologically advanced and
patient-friendly environment. If you are a patient and would like to learn about the offerings of AMIGO,
please visit the BWH AMIGO page here.

Launched in 2011, AMIGO is one of the first operating suites in the world with a full array of imaging
modalities for use during procedures, enabling less invasive, more effective therapy. Encompassing
5,700 square feet, divided into three separate, et integrated sterile procedure rooms in which
multidisciplinary teams treat patients using multiple imaging modallties. Each room has a separate
entrance to the control corridor and support spaces.

MRI Room

Pls: Ferenc Jolesz, M.D.,
Clare Tempany, M.D.
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An interdisciplinary platform

v W pe

An open-source environment for An end-user application for
software developers clinical investigators and scientists

A software platform that is both easy to use
for clinical researchers and easy to
extend for programmers
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ﬁb An extensible platform

= 2] ~
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CleaverExtension CardiacAgastonMeas ChangeTracker AirwaySegmentation CornerAnnotation CurveMaker
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3D Slicer supports plug-
ins called Slicer
extensions available from
the Extension Manager

Allows end-users to select
extensions useful to them,
without having to
download the entire
extension archive.

Built Nightly with Slicer
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3D Slicer in practice

o Slicer works on Windows,
Linux, and Mac

 Slicer is distributed under a
SD-style license agreemen
e with no restriction on use

-

3DSlicer

Get Slicer 4.

Slicer 4 is the latest version of 3D Slicer, a free,

3D Slicer is distributed under a permissive BS:

4.4.0 64 bit installer 4.4.0 64 bit Installer 4.4.0 64 bit archive
64 bit 2014-11-02 2014-11-02 2014-11-02
123774 (164.2M8) 123774 (224.0M8) 123774 (244.3M8)
stable
release
4.3.0 32 bit installer
32 bit 013-09-06
122408 (157.2M8)
nightly 64 bit installer nightly 64 bit archive
64 bit 2014-11-14 14-11-14
123783 (164.2MB) 123783 (244.3M8)
nightly R—
build

nightly 32 bit installer
32 bit 2013-11-24
22717 (159.0MB)

Iatest version of XQuartz. t
10.9.4 upgrade

System requirements
Slicer requires significant computer resources to run due to the large size of typical medical image data. A 64 bit processor, adequate RAM and a fast graphics card or GPU that
supports OpenGL is practical requirements to use Siicer effectively.

Slicer is built and tested on many hardware and software platforms. 3D Slicer runs on modern Windows, Mac OS X (10.6 and up), and a variety of Linux distributions.
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o/%) 3D Slicer in practice

Slicer works on Windows,
Linux, and Mac

Slicer is distributed under a
BSD-style license agreement
with no restriction on use

3D Slicer is for clinical
research use only, and is not
FDA approved or CE-marked.
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Slicer: Behind the scenes

. —— Slicer is built every

This Is running the bleeding edge swn trunk CDash code, and is updated frequently. Yo

e e e night on Windows,

- [
Windows7-VS2010-320its-QT4.7.1-PythonQt-With-Tel-CUI-

B e Mac and Linux
SnowlLeopard-g++4.2.1-64bits-QT4.7-PythonQt-With-Tck-CL-

factory-mac-64bits. kitware R )

Linux-ge+4.4.3-64bits-QT4.7-PythonQt-With-Tcl-CLI-Release

factory-ubuntu-64bits. kitware )

@
135

platforms

Windows7-VS2008-64bits-QT4.7.1-PythonQt-With-Tel-CUI-
factory-win7 kaware % 100073
fa 7 3aware S, QT4.7.1-PythonQe- TekCU-

Release ¥«

Buidd Name Build Time

& SnowLeopard-goed.2.1-Qt4.7.0-PythonQt-With-Tck-Release
@

11 hours ago
youplsclutah.edu ’mcm.a.o«mnm-wm-rm~ FEe
ers aware Linux-g++4.4-QT4.6.3-PythonQt-CLI-Release 3 hours ago

r~—y ’L:Xwg.mn.vmmuwu-vwmm 11 hours ago
ke ans S Nbeare Linuxg++4.4.3-64bit3-QT4.7-PyhonQt-With-Tcl-NoCLI- 11 hours ago

Coverage-Release WA\
Linux-g++4.3.3-QT4.7-PythonQt-With-Te-NoCLI-Release

sagarmatha. kitware

Buid Name

OpenSuse-c++4.5.0-64bits-QT4.6.3-PythonQt: -NoCLI-
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ﬁb An extensible platform
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3D Slicer supports plug-
ins called Slicer
extensions available from
the Extension Manager

Allows end-users to select
extensions useful to them,
without having to
download the entire
extension archive.

Built Nightly with Slicer
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Training Portfolio

.ﬁ' Loading a DICOM volume

Click to expand the DICOM > &)
Browser window. AR £

-
Slicer displays the -_
snapshots of the DICOM .t
images of the

CT_Thorax_Abdomen_CT
dataset

SUVmax = 7.53385 mg/ml
SUVmin = 5.01805 mg/ml
....................

‘ . °
" - 5
== g SUVmean = 3.39015 mg/ml i
. _ =Y
: ; vk
2011 Surcal

Jy Learning Objective

This tutorial
demonstrates how to
IR Diftusion Weighted imaging sc2 perform a radiation
P therapy research
workflow using the
SlicerRT extension:

Evaluation of the
isocenter shifting
adaptation method

Modular multi-level training for
expert and non-expert community

Tutorials and anonymized
datasets for end-users and
developers

Cross platform testing for quality
control

©2014 Surgical Planning Laboratory, ARR
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P Slicer clinical applications

Applied science oriented toward

patient-specific analysis in the presence
of pathology

Driving Biological Projects leading to
the development of new tools

©2014 Surgical Planning Laboratory, ARR
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Examples of clinical applications

« Radiotherapy: RT-specific
analysis dose accumulation
and dose comparison
(G.Fichtinger et al. Queen’s
University, Canada)
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‘ﬁ' Examples of clinical applications

3D Slicer 4.4.0
i Fa | 4 v

[ XOX )
ga &a [Modules: - [Tractography Interactive Seeding +| =~ & © @ @ & & < |E ¢~

* Diffusion Tensor

Q soslicer
» Help & Acknowledgement .
FiducialSeedingParameters * I m a g I n g tra Cto g ra p h y fo r
Parameter set
v o
Input DTI Volume patienti_dti H H
Input Fiducials, Model or Label Map | Tractography Seed n e u rOS u rg I Ca p a n n I n g
Output Fiber Bundle FiberBund...aphy Seed *
~ Seed Placement Options
Fiducial Region Size — 3.50mm 2
Fiducial Seeding Step Size = ————————=/1.00mm
Seed Selected Fiducials
Max Number of Seeds 100 2
~ Tractography Seeding Parameters
Minimum Path Length — 60.00mm 3
Maximum Path Length e ——800.00mm
Stopping Criteria Fractional Anisotropy
Stopping Value — 0.13 =
Stopping Track Curvature = =————————-=/0.70 5
Integration Step Length = =—————————--=0.50mm 5

~ Enabling Options
Create Tracts Initially As| Tubes 3
Enable Seeding Tracts ¥

~ Data Probe

o
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Slicer Training events

, :
.
D f) |
i . [
‘

— RSNA 2008, 2009, 2010,
2011, 2012, 2013, 2014

— MICCAI 2008, 2009, 2011,
2012, 2013, 2014

— SfN 2009, 2011

— SPIE 2012, 2013

— CAOS 2010

— CARS 2010, 2012, 2013
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N Tutorial Overview

Part 1: Introduction to 3D Slicer

Part 2: Basics of data loading and 3D interactive
visualization

Part 3: Measurement of volumetric changes
- large volumetric change: breast tumor case
- small volumetric change: meningioma case
Part 4. Measurement of metabolic activity

- squamous cell carcinoma case
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Part |ll: Basics of
Data Loading and
3D Visualization

©2014 Surgical Planning Laboratory, ARR Slide 22



Course Datasets

The Quantitativelmaging_Tuesday Dec2
directory contains three datasets located in
v | | Quantitativelmaging_Tuesday_Dec2 . .
v I dataset1_MR-Head the sub-directories:

MRHead_Scene.mrb

" aviocnene, - dataset]_MR_Head
C e smanene - dataset2_ChangeTracker

PET_CT_pre-treatment.mrb
» 8 PET1

dataset3 PETCT

Each dataset is in .mrb file format.
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Slicer mrb file format

®

¥ | | Quantitativelmaging_Tuesday_Dec2 A SlICer ml"b flle |S an al"ChIVG flle
" Metiead, Soame.mr that contains all data for loading
v | | dataset2_ChangeTracker . .
ChangeTrackerScene.mrb IntO SlICer4

v | | dataset3_PETCT
PET_CT_post-treatment.mrb
PET_CT_pre-treatment.mrb

» BN PET1

- The .mrb file is a .zip file with a
different filename extension.
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Welcome to Slicerd.4

3D Slicer 4.4.0

&a Modules: . | Welcome to Slicer s = PO «4d ~
om M1

i'.—.m:bv 'E"

Slicer

Welcome

s, Load DICOM Data [Gac; Load Data
#: Customize Slicer @& Download Sample Data
» Feedback
» About

» The Main Window
» Loading and Saving
» Display

» Mouse & Keyboard

S:0.000mm|~ Y & R: 0.000mm [ G A: 0.000mm

» Documentation & Tutorials BERE
» Acknowledgment
~ Data Probe

Slice Annotations:

wmr
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Slicer4 Minute Tutorial: Navigating the Application GUI

&8 28 E Mocies: < [BWelooms Stoe = Menu & Toolbar @ :- &« « - @@
The Graphic User N
Interface (GUI) of Slicer4 " Cumortn e | oSl 3D Viewer
integrates four S
components: .Module GUI
* the Menu Toolbar oo Panel
* the Module GUI Panel
* the 3D Viewer E—
* the Slice Viewer :
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Welcome to Slicer

|4 ACPC Transform

Q 3DSlicer

Welco

e meonoms |

All Modules

| Annotations

4 Data

= Datastore

& picom

/. Editor

.« Markups

@ Models

Fa Scene Views

“= Subject Hierarchy

Volume Rendering
@ Volumes
£\ Weicome to Slicer

» About
Wizards
» The Main Window Informatics
eg
» Loading and Saving
Diffusion
» Display o7
Filtering
2Mouse & Keyboars Surface Models
= | Converters
[~ DaaProe | Endoscopy
Utiities
Slice Annotations: Developer Tools
Legacy
Testing

Add Scalar Volumes
@ @ Modules: .| B Welcome to Slicer & c
| 4 AddManyMarkupsFiducialTest

# Annotations

& AtlasTests

% BRAINS Strip Rotation

& BRAINS Transform Convert
% BRAINSDWICleanup

& BSpline to deformation field

@ Cameras

ok Cast Scalar Volume

ok Charting

ok CheckerBoard Filter

E Colors

ok ColorsScalarBarSelfTest

% Compare Volumes

#k Create a DICOM Series

@ Crop Volume

o Curvature Anisotropic Diffusion
A Data

4 DataProbe

& DataStore

% Demon Registration (BRAINS)
& picom

#k Diffusion Tensor Scalar Measurements
ok Diffusion Weighted Volume Masking
ok DTlexport

ok DTlimport

% DWI Joint Rician LMMSE Filter
% DWI Rician LMMSE Filter

% DWI1to DTI Estimation

% DWI to Full Brain Tractography

©2014 Surgical Planning Laboratory, ARR

ok Extract Skeleton

ok Fiber Bundle to Label Map

ol fiber_visibility_crash2438

ok FiberBundleLabelSelect

4% Fiducial Registration

& FiducialLayoutSwitchBug1914
4k Foreground masking (BRAINS)
& Gaussian Blur Image Filter

& General Registration (BRAINS)
ok Gradient Anisotropic Diffusion
ok Grayscale Fill Hole Image Filter
ok Grayscale Grind Peak Image Filter
& Grayscale Model Maker

ok Histogram Matching

ok Image Label Combine

& JRC2013Vis

4% Label Map Smoothing

& Label Statistics

& Label Statistics (BRAINS)

& labelToggleBug2049

& Landmark Registration

. Markups

ok MarkupsinCompareViewersSelfTest
ok MarkupsinViewsSelfTest

ok Mask Scalar Volume

% Median Image Filter

& Merge Models

o Metric Test

& Model Maker

& Model To Label Map

@ Models

% Multiply Scalar Volumes

psSelfTest

% Resample DTI Volume

% Resample Image (BRAINS)
% Resample Scalar Volume
% Resample Scalar/Vector/DWI Volume
& Resize Image (BRAINS)
% Robust Statistics Segmenter
& RSNA2012ProstateDemo
& RSNAQuantTutorial

% RSNAVisTutorial

B sample Data

ok Scene Import (Issue 2428)

Simple Fiters
Simple Region Growing Segmentation
SliceLinkLogic

SliceraMinute

slicerCloseCrashBug2590

Subject Hierarchy

& SubjectHierarchyCorePluginsSelfTest

% SubjectHierarchyGenericSelfTest

ok Subtract Scalar Volumes

ok Surface Toolbox

ok Test Tractography Display

ok Threshold Scalar Volume

ok Tractography Display

o Tractography Interactive Seeding

& Tractography Label Map Seeding

ok Transform MRML Files to New EMSegmenter Standard
4 Transforms

& Vector Demon Registration (BRAINS)

& Vector to Scalar Volume

B View Controllers

ok ViewControllers Slice Interpolation Bug 1926
@ Volume Rendering

% VolumeRenderingSceneClose

@ Volumes

& Voting Binary Hole Filling Image Filter

B\ Welcome to Slicer

fededede 20 7
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ColorsScalarBarSelfTest
Compare Volumes
Create a DICOM Series
# Crop Volume

Cutvature Anisotropic Diffusion
i Data
+# DataProbe

DataStore
+# Demon Registration (BRAINS)
# DICOM

= 4: Diffusion Tensor Scalar Measurements
+ Diftusion Weighted Volume Masking
4+ DTlexport
+ DTiimport
4 DWI Joint Rician LMMSE Filter
% DWI Rician LMMSE Filter
DWiI to DTI Estimation

4 DWI to Full Brain Tractography
% DWI Unbiased Non Local Means Filter

# DWIConverter
Editor

# EMSegment Command-ine

i EMSegmenter with Atlas

& EMSegmenter without Atias

# Endoscopy

4 Event Broker

+# Execution Model Tour

# Expert Automated Registration

i Extension Wizard

 Extract Skeleton

4 Fiber Bundle to Label Map

+ fiber_visibility_crash2438

# FiverBundleLabe!Select

% Fiduclal Registration
FiduciallayoutSwitchBug1914
Foreground masking (BRAINS)
Gaussian Blur Image Filter
General Registration (BRAINS)
Gradient Anisotropic Diffusion
Grayscale Fill Hole Image Filter
Grayscale Grind Peak Image Fitter
Grayscale Model Maker
Histogram Matching
Image Label Combine
JRC2013Vis
Label Map Smoothing
Label Statistics
Label Statistics (BRAINS)
labelToggleBug2049
Landmark Registration
Markups

4 MarkupsinCompareViewersSeifTest

# MarkupsinViewsSelfTest
« Mask Scalar Volume
Median Image Fitter
Merge Models
Metric Test
« Model Maker
Model To Label Map
© Models
+ Multiply Scalar Volumes
MultVolumeExplorer
# MultiVolumelmporter
& N4ITK MRI Bias correction

- g g
3¢ OpenIGTLinkIF
# Orient Scalar Volume
# Otsu Threshold Image Filter
# Performance Tests
# PET Standard Uptake Value Computation
+# Probe Volume With Model
% Reformat
# Resample DTI Volume
 Resample Image (BRAINS)
Resample Scalar Volume
Resample Scalar/Vector/DWI Volume
# Resize Image (BRAINS)
# Robust Statistics Segmenter
# RSNA2012ProstateDemo
# RSNAQuantTutorial
# RSNAVisTutorial
@ Sample Data
# Scene Import (Issue 2428)
4 Scene Performance
 Scene Views.

Slicer4.4.0 contains
more than 100
modules for image
segmentation,
registration and 3D
visualization of
medical imaging data

©2014 Surgical Planning Laboratory, ARR
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P 3D Data Loading and Visualization

* Open the directory Quantitativelmaging_Tuesday
_Dec2 on the Desktop

| Quantitativelmaging_Tuesday_Dec2

v | | dataset1_MR-Head
MRHead_Scene.mrb

ChangeTrackerScene.mrb
v | | dataset3_PETCT
PET_CT_post-treatment.mrb

=P « Select the file MRHead_Scene.mrb

« Select the directory dataset1 _MR-Head

A_LiiL This file is composed of an MR scan of the brain and 3D

surface reconstructions of anatomical structures, from

The data are part of the SPL-PNL Brain Atlas developed

by Talos, Jakab, Kikinis et al. The atlas is freely available
for download at:

http://www.spl.harvard.edu/publications/item/view/2037
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®

Slicer4 Minute Tutorial: Load a Scene

ga & 23 |Modules:

Drag and drop the file M:RHead_Scene;mrb
Welcome

sy Load DIC
0 @ Cusivinize
[» Feedback
| » About
[» The Main Windox
[ Loading and Sav
[» Display
[» Mouse & Keyboa
[» Documentation &

| » Acknowledgment

| v Data Probe

Slice Annotations:

£\ Welcome to Slicer &

- U0 ed s
= 1

t-E A R

ome

o A

@O'[ . « Quantitativelmaging_Tuesday_Dec2 » datasetl _MR-Head

Organize v || Open Share with ~ New folder == -
e *  Name . Date modified Type Size

" | | MRHead_Scene.mrb 11/28/201411:24 ... MRB File 20,757 KB

E
=5

=

E -

MRHead_Scene.mrb Date modified: 11/28/2014 11:24 AM
Size: 20.2 MB

Date created: 11/28/2014 4:00 PM
MRB File

wnr

0.000mm
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Slicer4 Minute Tutorial: Load a Scene

®

&a Modules: . | Welcome to Slicer il OQQ O @« & ~ t v B M= R | 4~ g A
ex [l
#) sosiicer
g
Add data into the scene
Load DICOM Data = Choose Directory to Add| Choose File(s) to Add Show Options
# Customize Slicer © Dow 4 File Description
~ v ...elmaging_Tuesday_Dec2/dataset1_MR-Head/MRHead_Scene.mrb \MRB Slicer D. :\
| » Feedback b
| » About

[ » The Main Window

| » Loading and Saving

Click on OK to load the data to Slicer

| 7 WIUUSE o neywvaiu

| » Documentation & Tutorials

@OK || X Cancel || G

| » Acknowledgment

| v Data Probe

Slice Annotations:| ‘=

wmr

(]
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Slicer4 Minute Tutorial: Viewing the Scene

[ ] 3D Slicer 4.4.0

g &a Modules: . | Welcome to Slicer =m0 Q09O &l 2
ex E1E

®

B

t-8 A+ @P

3DSlicer

(O

Welcome
When the scene is finished loading, s
Slicer displays: Sample Data

*a 3D model of the head in the 3D
Viewer, and

*anatomical MR slices of the
brain in the 2D Slice Viewers.

1

Slice Annotations: | ‘=

L
E
B
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Slicer4 Minute Tutorial: Exploring Slicer’ s functionality

806

Flle Edit View Help

ACPC Transform
Add Scalar Volumes

To access the Models -

module, browse
through the list of

modules...

& |Modules: “:, [\ Welcome to Siicer 2y ::::;a“oj‘s
AllasTests
@ Annotations BSpline Deformable Registration
3DSlicer A Data BSpline to deformation field
& DICOM @ Cameras
~ Editor Cast Scalar Volume
Welcore w SergeTcks
#a Scene Views @ffEckerBoard Filter
4 Transforms = oo
Lond DicOM D”%! View Conizglipes Create a DICOM Series
Customize Slicer | 9/ Rendering @ Crop Volume
j @ Volumes Curvature Anisotropic Diffusion
|3\ Welcome to Siicer  Data
.| DataProbe
.| Demon Registration (BRAINS)
1 Informatics »|& DICOM
Registration »|  DICOM to NRRD Converter
Segmentation ,|  Diffusion Tensor Scalar Measurements
Quantfication )| Diffusion Weighted Volume Masking
| Diffusion ,|  DTIChallengeExplorer
IGT ,|  DTlexport
1 Fitering ,|  DTimport
S | Ssurface Models »|  DWI Joint Rician LMMSE Filter
1 Converters »|  DWIRician LMMISE Fitter
| Endoscopy ,|  DWito DTI Estimation
Uities »|  DWIto Full Brain Tractography
Developer Tools ,|  DWIUnbiased Non Local Means Filter
Legacy »| ~ Editor
Testing » EMSegment Command-ine
Workin Progress | EMSegmenter with Atias
[} without Atlas
Endoscopy
Event Broker

~ Data Probe

R

Execution Model Tour

Expert Automated Registration
Extract Skeleton
fiber_visibility_crash2438
Fiducial Registration
Foreground masking (BRAINS)
Gaussian Blur Image Filter
General Registration (BRAINS)
Gradient Anisotropic Diffusion
Grayscale Fill Hole Image Filter
Grayscale Grind Peak Image Filter
Grayscale Model Maker
Histogram Matching

Image Label Combine

Intensity Difference Change Detection (FAST)

Label Map Smoothing
Label Statistics
labelToggleBug2049

Linear Registration

Mask Scalar Volume
Median Image Filter
Merge Models
Model Maker
Model To Label Map

# Models

Multiply Scalar Volumes
MultiVolumeExplorer
MultiVolumelmporter
N4ITK MRI Bias correction
3€ OpenlGTLinkIF
Orient Scalar Volume
Otsu Threshold Image Filter
Otsu Threshold Segmentation
Performance Tests
PET Standard Uptake Value Computation
Probe Volume With Model
@ Reformat
RegAladin
Resample DTI Volume
Resample Image (BRAINS)
Resample Scalar Volume
Resample Scalar/Vector/DWI Volume
Rigid Registration
Robust Multiresolution Affine Registration
Robust Statistics Segmenter
RSNA2012ProstateDemo
RSNA2012Quant
RSNA2012Vis
B sample Data
Scene Import (Issue 2428)
Scene Views
SelfTests
Simple Region Growing Segmentation
SiiceLinkLogic
SiiceraMinute
slicerCloseCrashBug2590
Subtract Scalar Volumes
Threshold Scalar Volume
Tractography Display
Tractography Interactive Seeding
Tractography Label Map Seeding
Transform MRML Files to New EMSegmenter Standard
< Transforms
Vector Demon Registration (BRAINS)
Vector to Scalar Volume
View Controllers
ViewControllers Slice Interpolation Bug 1926
® Volume Rendering
@ Volumes
Voting Binary Hole Fillng Image Filter
WebGL Export
2\ Welcome to Slicer

¥
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Slicer4 Minute Tutorial: Switching to the Models Module

®

g

e 3D Slicer 4.4.0

8% w B® Modules: . [@ Models = Q0190 &« 2 Bt -6 wh + 1@
1

@®
@ 30Slicer

[» Help & Acknowledgement J

Include Fibers . Scroll to... N
= Scene

= hemispheric_white_matter.vtk 1.00

= left_eyeball.vtk W 1.00

= optic_chiasm.vtk 1.00

= optic_nerve_L.vtk 1.00

= optic_nerve_R.vtk 1.00

= optic_tract_L.vtk 1.00

= optic_tract_R.vtk 1.00

= right_eyeball.vtk W 1.00

= Skin.vtk 1.00

- alall hAana il 4 Nn
| » Information J
|» Display |
|» Clipping ]

[v Data Probe: /var/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml|

Slice Annotations: | & |

wmr

©2014 Surgical Planning Laboratory, ARR Slide 34



®

Slicer4 Minute Tutorial: Basic 3D Interaction

3D Slicer 4.4.0

‘e0e@
ta & Modules: . | @ Models = Q0 19O «d 2

e M1HE
@ 3DSlicer

| » Help & Acknowledgement |

Include Fibers . Scroll to... (o))

Position the mouse -l
in the 3D Viewer. i

Hold down the left ]
mouse button and \
drag to rotate the

m Od e I . 1ti9p4d...ene/MRHead_Scene.mrml|
|

L L D)

L
F
B

t-8 R+~ @A
R
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Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

3D Slicer 4.4.0

ga & % |Modules: . [@ Models = Q09O @l v Bt~ 8 = |+ @@
oo HH : 15:-27.188mm |
O .| % +| Axial sgr.le ¢
E 3DSlicer Toggle slice
v visibility in 3D
[» Help & Acknowledgement | = v ‘
Include Fibers . Scroll to... (2] \T\
= Scene =
- hemlsphenc whne matter.vtk 1.00
st 100
1.00
Click on the Slice Visibility
1.00
1.0g
1.0
o icon w00
1.(\(\

to display the Axial Slicein.
the 3D Viewer|

VIRHead_Scene.mrml|

Slice Annotations:| = |

L
F
B

©2014 Surgical Planning Laboratory, ARR Slide 36



Slicer4 Minute Tutorial: 3D Visualization

Slicer adds a view of
the Axial slice in the
3D View.
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Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

3D Slicer 4.4.0

& |Modules: . | @ Models =009 O @ 4 -

e @1
@ 3DSlicer
> o
: o)

| » Help & Acknowledgement 1

t-1BE R |4

Include Fibers . Scroll to... NE2
Click on the layout menu in ki
the toolbar, and select the i
Conventional layout ==

[¥ Display J

[» Clipping \

| ~ Data Probe: /var/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrmi|

Slice Annotations: | &

L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

®

Select the model Skin.vtk

[ ] [ ]
&a g |Modules: . | @ Models

:@ 3DSlicer

= left_eyeball.vtk
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.
= optic_tract_RM%
= right_eyebal
; n.vtk

e skull_bone.vtk

. Click to expand the tab Display
, Click to expand the tab Color

! :Change the opacity of the model from
1.0 to 0.0.

» Representation

~ Color

Color: #ffddce

Opacity: 1.00 |2
Edge Visibility:

Edge Color: m #000000

» Lighting =
~ Data Probe: /var/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml

Slice Annotations: | &

L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

®

3D Slicer 4.4.0

The model of the skull bone ~ :-cosoez & t-asn -@-
and eyeballs become visible — —

through the model of the skin in “i&
the 3D viewer. i
|
(skin model opacity =0.5)
Opacity: g (0502
E:g: \g:;:;my m #000000

~ Data Probe: /var/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml|

Slice Annotations: | &

L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

®

3D Slicer 4.4.0

[ ]
&a Modules: . [ @ Models = Q0 QIO «d s

g

3DSlicer

@

= left_eyeball.vtk W 1.00
» optic_chiasm.vtk 1.00
= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk .
= right_eyeball.vtk 1.
. Skin.vtk

= skull_bone.vtk

[N o PR

» Information

v Display

The model of the skin becomes
invisible in the 3D viewer.' :

(skin model opacity = 0.0):-~
(skull model opacity = 1.0)

|
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Slicer4 Minute Tutorial: 3D Visualization

®

3D Slicer 4.4.0

Clickon the Slice | -oseoia
Visibility

icon in the Green Slice "z ~
Viewer 2 Rl
. =
to display the Coronal il
Slice in the 3D Viewer. |
» Representation
;o?:::?r ( [ #ffddce J
Opacity: B \Lﬁfl
E:g: g.;i::my:‘ m #000000 \
» Lighting 1] G S == = A: -34.500mm |
< . vaoro:% w8 4

|~ Data Probe: /var/folders/zw/gbtj9p4d...ene/MRHead_Scene. mrmH §
& [ .| &2 None

< B |None

Slice Annotations: \ .

. | grayscale

L
E
B
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Slicer4 Minute Tutorial: 3D Visualization

3D Slicer 4.4.0

The Axial and Coronal
Slices are displayed in
the 3D Viewer.

-- Scene
= hemispheric_white_matter.vtk

= left_eyeball.vtk

= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk

= skull_bone.vtk

| » Information

| ~ Display
» Visibility

» Representation

- CAlar

|~ Data Probe: /var/folders/zwlgbtj9p4d...ene/MRHead_Scene.mrnﬁ

Slice Annotations:| &'

W

]
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Slicer4 Minute Tutorial: 3D Visualization

‘e0e@ 3D Slicer 4.4.0

5 £ Modules: . | Models ;SeleCt the 3D model
B e skull_bone.vtk in the Model
| » Help & Acknowledgement | .
. Hierarchy.

Include Fibers Scroll to... £x
= Scene
= hemispheric_white_matter.vtk 1.00
= left_eyeball.vtk W 1.00
= optic_chiasm.vtk 1.00
2 Click t d the tab
- opleaa L ik i UIICK 1O expan e la
: B -l
: Visibilit the Displ
Skin.vtk
o ir “: Visibility in the Display
pannel
| » Information
| ~ Display )
¥ Visibility
Visible: 4 H 1
. Turn on the Clip option
Clip: v [ m

Slice Intersections Visible:
Slice Intersections Thickness:| 1 px

» Representation

» Color

[ v Data Probe: Ivar/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml
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Slicer4 Minute Tutorial: 3D Visualization

®

Browse through the coronal slicesto s o « < -
expose the 3D model of the white
matter, and the left and right optic

nerves.

» optic_chiasm.vtk 1.00
= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
= optic_tract_R.vtk 1.00
= right_eyeball.vtk M 1.00
= Skin.vtk 0.00
.. skull_bone.vitk 1 1.00

» Information

~ Display

¥ Visibility

Visible: v

View: Al

Clip: v

Slice Intersections Visible:

Slice Intersections Thickness:|1 px

» Representation

» Color

» Data Probe: Ivar/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml|
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Slicer4 Minute Tutorial: 3D Visualization

®

3D Slicer 4.4.0
=0 QI§O® &« @ « t-lE R+~ @A
ex [1E

Now make the skull

] ] ] (a]
invisible. =
4
= hemispheric_white_matter.vtk 1.00
= left_eyeball.vtk W 1.00
= optic_chiasm.vtk 1.00
= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
= optic_tract_R.vtk 1.00
= right_eyeball.vtk M 1.00
= Skin.vtk 0.00
= skull_bone.vtk 1l 1.00
| » Information
| ~ Display
~ Visibility
Visible:
View: All <
Clip: v
Slice Intersections Visible:
Slice Intersections Thickness:|1 px B
» Representation
» Color

[ » Data Probe: /var/folders/zw/gbtjgp4d...ene/MRHead_Scene.mmﬁ\
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Slicer4 Minute Tutorial: 3D Visualization

®

Scroll the Coronal Slices to display the| : -2 s .2 -

3D Slicer 4.4.0

hemispheric white matter model in the
context of the image data in the 3D| -
Viewer.+ ~

1.00
1.00
= optic_chiasm.vtk 1.02
= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
= optic_tract_R.vtk 1.00
= right_eyeball.vtk W 1.00
= Skin.vtk 0.00
» skull_bone.vtk 1 1.00
| » Information |
| ~ Display |
~ Visibility
Visible:
View: All
Clip: o4
Slice Intersections Visible: _|H
Slice Intersections Thickness:| 1 px 2

» Representation
» Color

[» Dé-ta El%be: Ivar/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml
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Slicer4 Minute Tutorial: 3D Visualization

®

Select the hemispheric white matter model called
hemispheric_white_matter.vtk

Turn off its visibility.

=(Scene

| | = hemispheric_white_matter.vtk g

1.00
= left_eyeball.vtk B 1.00
= optic_chiasm.vtk 1.00
= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= Opuc_tract_L.ViK 1.0U
= optic_tract_R.vtk 1.00
= right_eyeball.vtk M 1.00
= Skin.vtk 0.00
< skull_bone.vtk 1.00
| » Information |
| ~ Display |
¥ Visibility
—————>> Visible:
View: All -
Clip:
Slice Intersections Visible:
Slice Intersections Thickness: | 1 px &

» Representation

» Color

[ v Data Probe: Ivar/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml
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Slicer4 Minute Tutorial: 3D Visualization

|

Slicer displays the optic nerve,
optic chiasm and optic tracts
overlaid on the MR images of
the brain.

®
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®

Close the existing scene and all its data

@ Slicer Edit View Help DO 4 D 8%E ) E Sat11:59PM Q =
eoe £a Add Data %0 3D Slicer 4.4.0
o, o DICOM - m - : 2 s - B . A
e é B Download Sample Data — ‘ . e. ) W O % ﬁ - t =5 &_ a
& Save £ ® 1

Recently Loaded >

(JRERST " Close Scene BW
4

Select File-=>Close |
Scene

= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk
= Skin.vtk

< skull_bone.vtk

This removes any dataset
previously loaded into Slicer.

Select File>Exit to exit the S
software

iene/MRHead_Scene.mrml|
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‘ﬁ' Summary

This first part of the tutorial has demonstrated:

» Basic description of the Slicerd4 Application Interface
 How to load a .mrb file containing volumes and models
* How to visualize these different datasets together

Next, we will use these building blocks to perform image
analysis and visualize quantitative results.
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Part ll: Analyzing
Volumetric
Changes
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‘ﬁb Example1: Large volumetric change

Case Courtesy of Dr. Macura, JHU

Clinical case: 45 y-0o woman
presenting with an infiltrating
ductal carcinoma in left breast

Pre- and post-treatment
Imaging shows large volumetric
difference in tumor size
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‘ﬁ' PreTherapy acquisition

Pre-Gad High resolution MR scan

Post-Gad High resolution MR scan
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‘ﬁ' Quantitative Imaging Processing Pipeline

Step #1: Non-rigid Registration of pre-Gad image to
post-Gad image

Step #2: Subtraction of registered pre-Gad image to the
post-Gad image

Step #3: Semi-automated segmentation of the
subtracted image

Step #4: 3D model creation

Step #5: Tumor volume computation

Processing time ~5-7 min
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‘ﬁ' Pre-therapy analysis (May 2013)

Subtract

Pre-Gad | P Post-Gad

Tumor volume (May): 75 cm3 Slide 56



PostTherapy acquisition

5mm

Pre-Gad High resolution scan

Post-Gad High resolution scan
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Post-therapy anaIyS|s (0ct 2013)

» @ <x v Axial < ‘postjxfpreGadfregistered * | @~ v Axial + | postTx_post-Gad

Post-Gad

DO s a—. ‘A«! ) "‘,.,“._ LA

Tumor volume (Oct) 0.9 cm3 'l" TN —

TR RN 2 . TREET G AT e



‘ﬁ' Example1: Large Volumetric Change

Tumor volume (May): 75 cm3 Tumor volume (Oct): 0.9 cm3
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Example 2: Small volumetric change

MR Scan1 2006

S: 28,

The second example is built upon
MR datasets of a meningioma case.

The following section will guide you
step-by-step through the
computation of small volumetric
changes between the baseline
(2006) and follow-up (2007) using
the Change Tracker module.

MR Scan2 2007 |

(Voxel dimension: 0.94mm x 0.94mm x
1.20mm, FOV: 240mm, Matrix: 256 x 256)
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‘ﬁ' Conventional measures of tumor response

Conventional anatomic imaging using
CT or MRI are often used to evaluate
tumor size and shape

Most clinical trials that evaluate new
chemotherapeutic drugs use changes
in uni-dimensional or bi-dimensional
measurements to assess response
(e.g. RECIST)

Slicer has several tools for applying
RECIST methodologies

©2014 Surgical Planning Laboratory, ARR
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Conventional measures of tumor response

®

[} 3D Slicer 4.4.0

2 & Modules: . | Welcome to Slicer = QO PO w2 Bt 1@ % & -@e
S: 1 &

ox B

(g

R ..

The Annotations module of
3D Slicer can be used to
measure diameters in a tumor
cross section, and to provide
interactive numerical
annotations.

(@]

=]

L

@
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Clinical Case: baseline scan (2006)

Baseline radiologist’ s
clinical impression:

* large falcine lesion is
identified.

* measures 3.10 cm
anteroposteriorly and 3.51 cm
in height.

* enhances moderately on
post gadolinium imaging.
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Clinical Case: follow-up scan (2007)

Follow-up radiologist’ s clinical
impression:

* |left frontal lobe mass appears
unchanged on all series.

* measures 3.3 x3.2cmin
maximum dimension.

* enhances moderately on post
gadolinium imaging.
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Clinical Case: follow-up scan

Follow-up radiologist’ s clinical
impression:

* |left frontal lobe mass appears
unchanged on all series.

* measures 3.3 x3.2cmin
maximum dimension.

* enhances moderately on post
gadolinium imaging.

- How has the tumor changed?

©2014 Surgical Planning Laboratory, ARR
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‘ﬁ' ChangeTracker: rationale for new approaches

More accurate and precise methods for understanding volume
changes may be useful when:

benign tumor change is being monitored, or

where small changes may be clinically significant but
difficult to assess with RECIST
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ChangeTracker: Load the dataset

®

ga & &a |Modules: . |@ Models = Q0019 O &« @ « t v @ A Fa -ae
. . . 1
v [ Quantitativelmaging_Tuesday_Dec2 22
v | | dataset1_MR-Head
MRHead_Scene.mrb e
1
v | | dataset2_ChangeTracker e0e@ Add data into the scene
Chan g eTrackerScene.mrb Choose Directory to Add| Choose File(s) to Add Show Options
: v File Description
v | | dataset3_PETCT « ...Tuesday_Dec2/dataset2_ChangeTracker/ChangeTrackerScene.mrb |MRB Slicer D. 4 |

PET_CT_post-treatment.mrb
PET_CT_pre-treatment.mrb
» |9 PET1

Drag and drop the file
ChangeTrackerScene.mrb
located in the directory
dataset2_ChangeTracker

| ¢JOK || ¥ Cancel

Click OK to load
the .mrb file into Slicer

[ Data Probe: var/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrm
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Loading the data

PP ——— .. Click on Welcome to .
B Slicer and select the R—
» Help & Acknowledgement 2 mOdU|e Dat

~ Display & Modify Scene
Nodes

The datasets of the
ChangeTrackerScene
appear in the anatomical
viewers. : :

Default Scene Camera

Default Scene Camera

Default Scene Camera

Compare1

Default Scene Camera1
2007-spgr1

2006-spgr1
SceneViewToplevelHierarchyNode1
Master Scene View

Slicer Data Bundle Scene View

Scene Model:| Transform $
Display MRML ID's
Show Hidden nodes

Filtor: -
» Data Probe: /var/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml
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Loading the data

D 3D Slicer 4.4.0

2 &a |Modules: 4 Data s = Q. Q9P O 4«4 2 B $~ fa o, M= Ke

B°

@ 3DSlicer

» Help & Acknowledgement |

| ~ Display & Modify Scene

The Slicer scene contains
two scans 2006-spgr1 and
2007-spgr1.

Deraunscene vamera
Default Scene Camera
Default Scene Camera & ; > R: 0.000mm
Default Scene Camera

Default Scene Camera

Default Scene Camera

Default Scene Camera

Default Scene Camera

Compare1

Default Scene Camera1

2007-spgr1

2006-spgr1
SceneViewToplevelHierarchyNode1
Master Scene View

Slicer Data Bundle Scene View

Scene Model:| Transform :
Display MRML ID's
Show Hidden nodes

Filtar:

» Data Probe: /var/folders/zw/gbtj9p4d...ene/MRHead_Scene.mrml
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®

ChangeTracker: exploring small volumetric changes

- - 3D Slicer 4.4.0-2014-11-13
&a |Modules: Al Modules 1= 0 © OO @
Annotations
r"\ 3DSlicer 4 Data
e = DataStore
# DICOM

elcon- e
Using the Modules Menu button,
select the Wizards->ChangeTracker.

@ ansivnnS

» Feedback
=8 - M View Controllers
» About ~|® Volume Rendering
ST @ Volumes
e vain Wincow £\ Welcome to Slicer
» Loading and Saving__| (7 S
- - Informatics 4
» Displa
2y, Registration ,
» Mouse & Keyboard Segmentation »
| Quantification »
» Documentation & Tutorials|  pjffusion »
» Acknowledgment IGT '
Filtering >
v Data Probe: /var/folders/zv Surface Models '
- Converters >
Slice Annotations:| i Endoscopy ’
Utilities »
Developer Tools >
L Legacy >
F Testing »
B BRAINS »
)

| Inanacified
e —
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®

ChangeTracker: a note about the Workflow wizard

The Workflow Wizard
guides the user through a
sequence of steps and has
the following components:

* the Step Panel
* the User Panel
* the Navigation Panel

Step Panel—

User Panel--

Navigation

@ 3DSlicer
w7

| » Help & Acknowledgement

| ¥ 1. Select input scans

Select the baseline and follow-up scans to be compared.

\ Load test data

Baseline scan: |Select a Volume

Followup scan:|Select a Volume

Panel-- L& e —

[ Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml|
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Step1: Select input scans

. Click to expand the tab ‘“1.Select input scans’

& & |Modules: ChangeTracker

®

. JN— Click on Select a Volume next to Baseline Scan

1 Selct input soans Select the volume 2006-spgr1

Select the baseline and follow-up scans to be cor

Load test data
Baseline scan:  2006-spgr1

Followup sosn{2007-spgr Click on Select a Volume next to Follow up Scan
Set the volume 2007-spgr1

™\

Click on the green arrow to the next step of the workflow

e
¢ o ‘ * \
Back Next () N = \

» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
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Step2: Define Region of interest

A Volume of Interest (VOI) Box Widget appears in the
anatomical viewers, and in the 3D viewer.

®

» Help & Acknowledgement

~ 2. Define Region of Interest
Define ROI that covers the object of interest.

Select ROI:| AnnotationROI

Define VOI
L-R Range:(.19.00 2 10.00 Sl
c o=@ ’
P-A Range:(_10.00 B 10.00 3 -
I-S Range: [.10.00 = 10.00 ol  R: 0.469mm
e—o

# Display Clipping box ¥ Interactive Mode

Q Back ‘ Next 5]

» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
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®

Step2: Define Region of interest

Browse through the Axial,
Sagittal and Coronal slice

viewers to get a close-up |

view of the tumor

Zoom in (Right mouse
down and push/pull).

Position the mouse

cursor in a viewer, hold
the shift button down on
the keyboard, and move
the mouse to display the
corresponding location in

" the two other viewers

ChangeTracker

it of interest.

3.1
—C
38.35
@e—0
X v Interactive Mode

@j9p4d...angeTrackerScene.mrmI

Next Q¢

tory, ARR

3D Slicer 4.4.0-2014-11-13

‘@Q%Q/

=

t~ @ R R

-@e

A: 26.696mm
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Step2: Define Region of interest

.‘ = SD Sllow 44.0-2014:11:13 Center the VOI fi rst:
2o &a |Modules: . | & ChangeTracker = Q09O & @ ~ H

ex IR =
B osce Left click on the central

| » Help & Acknowledgement

yellow dot and hold the
dmouse cursor down to
move the VOI

|~ 2. Define Region of Interest
Define ROI that covers the object of interest.

Select ROI:| AnnotationROI s B
Define VOI

L-R Rangei\-14.61 S 5.48 =
P-A Range: 1,07 3 e 38.10 B ign .
s s \Position the square in the

& Display Clipping box ¥ Interactive Mode

Wl center of the tumor in the
¥ slice viewer.

(€ Back | Next o

| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml| =
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Step2: Define Region of interest

[ @ 3D Slicer 4.4.0-2014-11-13

&a Modules: . | 4 ChangeTracker $| - Q 5] @ © % ﬁ Z t - @ M R = K

Y 3pslicer
>
| » Help & Acknowledgement
|~ 2. Define Region of Interest
Define ROI that covers the object of interest.
Select ROI:| AnnotationROI
Define VOI
L-RRange:[ 2517 2] [16.64 SES
: = 3
- ‘fany & A7 1n =)
PARange.‘9.07 g /\ [47.10 S
S Range: ‘L}: ‘42{597:} o R:-4.121mm A: 27.242mm

| s | Nienlav Clinnina hnavl « Intaractive Mnde

Next, resize the VOI:

Use the colored handles
to change the VOI extent

Q!

| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
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Step2: Define Region of interest

[ ] 3D Slicer 4.4.0-2014-11-13

3 &3 |Modules: . | & ChangeTracker = Q09O el 2 B It-8 R +- B

® R e e St 26.428mm
!‘; 3DSlicer
7

The VOI box and —
volume rendering of
tumor in yellow appearin -
the 3D Viewer E

B

L

I-S Range: [+ 8 (..
9 ‘Lﬂl‘ ‘L‘ U R:-4.121mm A: 27.242mm

" | Display Clipping box ¥ Interactive Mode

. (.ﬁ -\
C W,

\ »
\ oA “ o
(€ Back | Next [5) L é‘-’ 5 B " T ?
| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml| - ap— ~ \ - V) ,
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Step2: Define Region of interest

3D Slicer 4.4.0-2014-11-13

i B@ Modules: . | 4 ChangeTracker = Q0 Q|9 &« @ v

ex R
@ 3DSlicer
4

| » Help & Acknowledgement |

B w18 @

B

t- @ M R

| » 2. Define Region of Interest |
Define ROI that covers the object of interest.

Select ROI:/AnnotationROI a 7 r

Define VOI O .
LRRange: 2217 |3 A [1664 3] Flne-tune the VOI USIng
PARegsfgo7 (a0 [ -] the VOI Widget range
FSRange: [gg0 |2 o ese -] 8 sliders or by mOV|ng the

\T\ Display Clipping box v/ Interactive Mode

B \/Ol Widget handles in
3D view

_§i 4
Note: VOI Widget range sliders are color-coded to
o x| match VOI box Widget handles in 3D Viewer

| » Data Probe: /var/folc
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®

Step2: Define Region of interest

e

2. 38 Fo IMadiulac:

| & Chan~aTeanlAr

Select the viewing mode
‘Conventional Widescreen’

Define ROI that covers the object of interest.

Select ROI:| AnnotationROI

Define VOI

L-RRange:(.2217 |2 [16.64 B

S5
Sk

P-ARange: (g o7 2 [47.10 =2

I-S Range: (g go 2] [48.59 SEa

AH

" | Display Clipping box ¥ Interactive Mode

(€ Back | Next

| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml ~

©2014 Surgical Planning Laboratory, ARR

3D Slicer 4.4.0-2014-11-13

=009 O & @ v
R

E\ t - @ A fa

-@e

[ Conventional

Conventional Widescreen

[ Conventional Quantitative
4 Four-Up
B Four-Up Quantitative

[l One-Up Quantitative

[ Red slice only

= Yellow slice only

[T Green slice only
Tabbed 3D

[E Tabbed slice

B Compare

[T Compare Widescreen
|\[H Compare Grid
HH Three over three

[ Four over four

[ Two over Two

[ Side by side

B Four by three slice
[ Four by two slice
B Three by three slice

y B AL 27.710mm
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Step2: Define Region of interest

[ ] 3D Slicer 4.4.0-2014-11-13

2 &a Modules: . | 4 ChangeTracker = Q0190 &« 2 t- B Rl +-1B3 A

o= [l R
¢ !i= 3DSlicer
4

| » Help & Acknowledgement |

B

|~ 2. Define Region of Interest |

Define ROI that covers the object of interest.

Select ROI:| AnnotationROI 2
Define VOI
L-R Range: ‘m . A m‘7‘
P-ARange:go7 = - -' CACENCIE
I-S Range: [9.80 =] : 4;59 in
Slicer shows a closer ™
view of the volume
rendered tumor region.
@ Back Next Q|

| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml|
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®

Step2: Define Region of interest

o 3D Slicer 4.4.0-2014-11-13

- & |Modules: +# ChangeTracker 3] - 0. Q9P O©® « @ ~ t - o 8

!‘; 3DSlicer
w

| » Help & Acknowledgement |

g

|~ 2. Define Region of Interest |
Define ROI that covers the object of interest.

Select ROI:| AnnotationROI 2|
Define VOI

LR Rangei 2217 3 L
P-A Range:|g 07 5 (47.10 B
IS Range: [ggn 4] (4859 [z~

Zoom in and out, and | e
rotate the volume
rendered image to
explore the tumor
region in 3D.

[ Back | Next Q|

|» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml|
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Step2: Define Region of interest

- e 3D Slicer 4.4.0-2014-11-13
£,

&a |Modules: . | 4 ChangeTracker (=009 el s @ t~ fo R Ml = K

Conventional Widescreen
[E Conventional Quantitative

@ 3DSlicer
| » Help & Acknowledgement - FourUp Quantitative ni‘w':?

|+ 2. Define Region of Interest
Define ROI that covers the object of interest.

B Triple 3D
3D only
[ One-Up Quantitative

[ Red slice only

[ Yellow slice only

[ Green slice only

Tabbed 3D

[E Tabbed slice

E Compare »

Qalanrt RNI:| AnnntatinnRNI

Select ‘Four-Up’ to —
return to the initial view oo o

mode T

48.59 e

A: 28.827mm

# |Display Clipping box v Interactive Mode B8 Compare Grid

[ Three over three

[ Four over four

B Two over Two

[T Side by side

[ Four by three slice
e ] Four by two slice

~4Click on the green
S e | o og—==Zarrow to move to the

| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
next step
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®

Step3: Segment the tumor

. (0]
&a Modules: & ChangeTracker

3D Slicer 4.4.0-2014-11-13

= 00190 &« @ -
R

« & 4 v Axial
@ 3DSlicer = i i
# v 1.00 ; iff baselineROI_segmentation

Click on the pin icon in the top left | 000 2o

I B }\ baselineROI

corner of the red viewer (next to
the letter R)

Click on the double arrow icon (>>) |
to display the names of the two
volumes that Slicer has generated
automatically:
baselineROIl_segmentation and
baselineROI

379 2| -

R:-2.714mm i A: 28.056mm

[€) Back | Next ©

» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
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‘ﬁ' Segment the tumor
mn Baseline puammm
Step 1: :

VOI
definition

Step 2:
VOI
extraction

Step 3:
Segmentation
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Step3: Segment the tumor

eoce 3D Slicer 4.4.0-2014-11-13
& [Modules: . | 4 ChangeTracker =" Q0 QI9O «d Bt~ wn +- @
EEjol:l ————
« & < v|Axial B < P 5 @
‘ N - SRR

Q greticer @ = +/1.00 - @‘baselineROI_segmemation S
| » Help & Acknowledgement || @ |0.00 |:|t l None s
[~ 3. Segment the analyzed structure | ‘ v||baselineROI

Segment the structure in the selected ROI.

| ~ Basic settings

Choose threshold:|99 E: (379 [ ]

| » Advanced settings

= The 3D Viewer
shows the
corresponding 3D
volume-rendered
image of the tumor

€ Back | Next Q]

| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrmli|
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Step3: Segment the tumor

3D Slicer 4.4.0-2014 l

& &a Modules: +# ChangeTracker = Q. O @ (_) % ﬁ] 7z B |t~ fa S 8 e
@®

Select the layout FourUp in the
layout menu to display the
- volume rendered segmentation

®

[ )
S
oA
(\ rrrrrrrr

» Help & Acknowledgement

v 3. Segment the analyzed structure
Segment the structure in the selected ROI.

~ Basic settings

(379 |2

é‘?hoose threshold:|144 2
» Advanced settings

7 A: 28.056mm

In the Basic Settings Tab:
Modify the segmentation of the
tumor by moving the threshold
range slider

(€] Back Next (5]

» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
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Step3: Segment the tumor

e 3D Slicer 4.4.0-2014-11-13

2 & |Modules: . | & ChangeTracker = Q0090 &« d « B

@®

®

B

Scroll through  »-
the Slices until the Acknowledgement

nent the analyzed structure

Seg m e ntatio n the structure in the selected ROL.
appears optimal. e s : w5
ruavariced settings
Click on the green
© | o arrow to move to the

| » Data Probe: ivar/folders/zw/gbtj9p4d...angeTrackerScene.mrml

next step
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Step4: Select the Analysis Method

- - 3D Slicer 4.4.0-2014-11-13
4,

&a |Modules: . | 4 ChangeTracker ™ QQIPO &« @ v B ot A Fo M=K

ex IR

®

@ 3DSlicer

| » Help & Acknowledgement

|~ 4. ROI Analysis
Select the analysis method for the selected ROI.

~ Basic settings
é Intensity Difference Change Detection (FAST) ¥

» Advanced settings

Select the Basic Setting
‘Intensity Difference Change Detection (FAST)’
[

Click on the green arrow
to move to the next step

(€ Back \ Next 5)

|» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
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Step4: Select the Analysis Method

B 3D Slicer440
File Edit View Help
& |Modules: . +# ChangeTracker

®

- e

» Help & Acknowledgement

- 5. ROI Analysis Results

IntensityDifferenceMetric

Growth: 2.01 mL (19516 pixels), or 1.44%
Shrinkage: 0.00 mL (O pixels), or 0.00%
Total: 2.01 mL (19516 pixels), or 1.44%
» @+ v Axial

200000

Left click on the slice menu to display the volumes that have been
generated:

- followupROI correspond to the subvolume that has been extracted
around the tumor in the 2007-spgr_1 dataset

- changesVolume_IntensityDifferenceMetric corresponds to the
change between the 2006 and 2007 scans



Step4: Select the Analysis Method

[ JOX ] 3D Slicer 4.4.0-2014-11-13
Py

&a |Modules: & ChangeTracker s = Q_ QP ©& &« @ ~ J . e

<@ < v Axial

@ 3DSlicer

[» Help & Acknowledgement / || @
|~ 5. ROI Analysis Results / |
IntensityDifferenceMetric

Growth: 1.88 mL (18277 pixels), or 1.21%

Shrinkage: 0.00 mL (0 pixels), or 0.00% H - S:29.015mm

Click on links icon in the Red Slice Viewer menu to link all three
viewers.

Click on the . icon to adjust the size of the image to the size of the
window, and browse through the slices to display the images

# v|1.00 || i [changesVolume...ferenceMetric + |

0.00 [2| @ | None

- @] followupROI

(€ Back Next )

‘ » Deta Probe: varfolders/zw/gbiBpad...ange TrackerSoene.mm ““
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Final Step: Change Tracker Results

@® 3D Slicer 4.4.0-2014-11-13
ta Modules: & ChangeTracker = 0. 09O @«d s
ex [lR

The change in volume is shown |
overlaying the tumor image and |
in the 3D Viewer:

magenta = growth
green = shrinkage

(€] Back Next O
» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml

200099
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——in the red slicer viewer

Visualization of the change in pathology

The results of the analysis are
displayed in the “Compare
View” layout

3D Slicer 4.4.0-2014-11-13
=0 Q019 O & B
18S: 2!

v‘v_@;@v vgf’
1"7

*BaselineROI: Six consecutive
slices for the ROI in Baseline
Scan (top row), and

*FollowupROI: Six corresponding
consecutive slices for the ROl in

Follow Up Scan (bottom row). ..”’
*A zoomed view of the axial slice h AL N :

- S: 25.015mm
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Visualization of the change in pathology
The Crosshairs in CompareV|ew show corresponding
mvoxels in Scan1 and Scan2 for voxel-wise comparison.

[» Help & Acknowledgement F| 0.00 *| @ lNone B
=

To0E
[~ 5. ROI Analysis Results ‘ g |followur>ROI

IntensityDifferenceMetric

Growth: 1.88 mL (18277 pixels), or 1.21%

Shrinkage: 0.00 mL (0 pixels), or 0.00% aha— ]8:20.703mm
Total: 1.88 mL (18277 pixels), or 1.21% o @) vAxal s |EE o @ F W
e l1.00 {: o ‘changesVqume_IntensityDiﬁerenceMetric s
0.00 {:|E| None 5 ‘
- | B baselineROI 4|

N

<@ o v|Akal  :]m o B F W@

@ # v/ 1.00 {: B ‘changesVqume_ImensityDifferenceMetric : ‘
0.00 [/ g None e

00 [ @] followupROI N

(€ Back ‘ Next ©
| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml|
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Change Tracker Results

3D Slicer 4.4.0-2014-11-13

& |Modules: ;\'..I;ChangeTracker 2| - 0. QP « @ ~ E. %~ Ao fo, ‘?H a Aa
cgol:t  ——— —e—————Ckol Rl
<@ ~Adal ¢+ ER @ 5 W
@ o & v\1.00 = ﬁ‘changesVqume...ferenceMetric o

‘

[0.00 ?|| None o P\ %
700 - @) folowupRoI : Bl

The metrics calculated indicate the
volume and percentage of tumor —_—
growth between the two time points. | .

| » Help & Acknowledgement

|~ 5. ROI Analysis Results J“

IntensityDifferenceMetric

Growth: 1.88 mL (18277 pixels), or 1.21%
Shrinkage: 0.00 mL (0 pixels), or 0.00%
Total: 1.88 mL (18277 pixels), or 1.21%

® | \‘MI baselineROI
| -

de o w85

o & v|1.00 = ‘changesVqume_IntensityDifferenceMetric :‘

o H (0,00 %) g | None 2

|:E|| followupROI ¢ ‘
» : . y “" v A '

(€ Back ‘ Next [5)

| » Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml|
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P

Change Tracker module

The 3D Slicer ChangeTracker module is a research tool for
evaluating volumetric changes and bring additional complementary
information to RECIST measurements

However, three current requirements are needed for Change
Tracker to produce adequate measurements:

1) Clear Tumor boundaries

2) Contrast enhanced images only

3) Homogenous enhancement across timepoints

The Change Tracker module has not been tested for tumors with
changing necrosis.
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Clear the scene and its data

e o 3D Slicer 4.4.0-2014-11-13
&a |Modules: . | & ChangeTracker I Q09O «@ «

@®

@ 3DSlicer

» Help & Acknowledgement

Clear the previous scene. . .
Select File->Close Scene ) .oo00%

s), or 1.21%

Select File=> Exit and restart
Slicer

(€] Back Next O
» Data Probe: /var/folders/zw/gbtj9p4d...angeTrackerScene.mrml
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ChangeTracker: Exploring small volumetric changes

®

This tutorial demonstrated:

» a method to quantify small volumetric changes in pathology.
» visualization of these changes in the anatomical context

» use of Slicer’s “Compare Viewer” to simultaneously explore
baseline and followup studies.

Next, we will demonstrate combined visualization of
PET/CT studies and SUV computation.
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PET/CT Visualization and Analysis

Part lll: PET/CT
Analysis

Sonia Pujol, PhD

Kitt Shaffer, MD, PhD
Hatsuho Mamata, MD, PhD
Ron Kikinis, MD
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‘ﬁ' Goal of the tutorial

The goal of this tutorial is to
guide you step-by-step
through the Standard
Uptake Value (SUV)
computation of PETCT data
of a squamous cell
carcinoma case, pre- and
post- treatment

©2014 Surgical Planning Laboratory, ARR
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ﬁ) FDG-PET SUV

« Standardized Uptake Value (SUV) is a semi-quantitative measure
derived from the determination of tissue activity obtained from a
clinical PET study

SUV = Tissue Concentration of Radioactive Tracer x
Patient Weight / Injected Dose

« Under certain circumstances, 18-F Fluorodeoxyglucose (FDG)
SUV correlates with metabolic rate of glucose and/or the number of
viable tumor cells
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‘ﬁ' Tutorial Case

Pathology: poorly differentiated
squamous cell carcinoma

Treatment: radiotherapy and
chemotherapy (weekly cis-platin)

Two 18F-FDG PET and CT scans
acquired within a 5-month interval.

©2014 Surgical Planning Laboratory, ARR
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PETCT tutorial: Clinical Case and Data

v || Quantitativelmaging_Tuesday_Dec2 The datasets are |Ocated in
v | | dataset1_MR-Head
MRHead_Scene.mrb \dataset3_PETCT
Vi mcatnaste-ChangsTiacker The directory contains two .mrb files

ChangeTrackerScene.mrb
v | 7| dataset3_PETCT

PET_CT_post-treatment.mrb
PET T pre.treatment.mrb - PET_CT_pre-treatmen_t.mrb
» B PET1 corresponds to the baseline

- PET_CT_post-treatment.mrb
corresponds to the follow-up scan.
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Loading the PETCT scene

(®)
mm 1
Drag and drop the file PETCT_pre-treatment.mrb

Show Options

T - B — e — | o P
i Customize Slicer © Dow o IS .Descrlptlon
v ...day_Dec2/dataset3_PETCT/PET_CT_pre-treatment.mrb | MRB Slicer Data Bundle 2

~ Feedback |

_ Share your stories with us an
how 3D Slicer has enabled you

We are always interested in improving {
submission will be carefully read.

See more at hitp:/goo.ql/t
» About |

» The Main Window

Click OK to load : = [OK ] X Gance
the .mrb file into Slicer

L
E
B
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Loading the PETCT scene

[ ] 3D Slicer 4.4.0

& |Modules: 4 Data =0 QO PO ad s

Select the module Data

The CT dataset appears in the
anatomical viewer

viewl

View1

Default Scene Camera
Default Scene Camera
Default Scene Camera || |
Default Scene Camera
CT1 P — 1 R:-3.516mm i A: 41.172mm
PET1

PET1-label

Slicer Data Bundle Scene View_1

Scene Model:| Transform $
Display MRML ID's
Show Hidden nodes

Filter: -

v Data Probe
Slice Annotations:| ‘=
| Compare1 RAS: (118.0, -290.7, 6.0) Axial Sp: 1.0

L None
F None
B None
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Loading a PETCT dataset

[ ] 3D Slicer 4.4.0
2

% &a |Modules: 4 Data = Q. PO « @ ~ B t - fa Fe, Ml = K

B -

» Help & Acknowledgement 1.00 | [@|CT1

.| @ |PET1

v D|splay & Modify Scene

Left click on the pin icon in the top left corner to dlsplay the red slice viewer
menu.

The CT1 volume is displayed in the Foreground viewer
The PET1 volume is displayed in the Background viewer

Use the slider to fade between the Bg viewer and the Fg viewer to display
the PET volume overlaid on the CT volume

B -l&’%‘ \
A e R R
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Visualization of PETCT data

o [ J 3D Slicer 4.4.0

&a Modules: . | « Data ™ Q00|90 &«@ s B ot~ A Fo -ae

eon T 1S:-171.761mm

®

B < @ | # [+ Axial R
Y 3ps)i

Sticer # ~[1.00 |2/ & | PET1-label .
» Help & Acknowledgement 4-—-5} 0.50 7 /[@ CT1 5

~ Display & Modify Scene H -| B |PET1 s

Default Scene Camera A
Compare1
View1

Viewr Change the opacity of the CT1 volume to 0.50 to

Default Scene Camera . . . .
et Seene Camera— (iSplay the CT images overlaid on the PET images
Default Scene Camera

CT1 - g ——

PET1

PET1-label

Slicer Data Bundle Scene View_1

- R:-3.516mm - A: 41.172mm

Scene Model: Transform s
Display MRML ID's
Show Hidden nodes

Filter: -
v Data Probe: /var/folders/zw/gbtj9p4d...CT_pre-treatment.mrml

Slice Annotations:|

o
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Visualization of PETCT data

e 3D Slicer 4.4.0
E

& Modules: . |@ Volumes "0 0|90 @@ s ot~ Ao Fo, -3 e

®

{D 3DSlicer
=4
» Help & Acknowledgement

Active Volume | CT1
» Volume Information

~ Display
Lookup Table:| [Jf Gre

Itsrpolste: _ < Hold the left mouse button down, and move the

Window Level editor pres¢

L 1 [ mouse cursor up/down and left/right to adjust the
wszr - vanawi Window and level of the PET images

Threshold: Off :
) b
-3634 3680 . »
» Histogram y

v Data Probe: /var/folders/zw/gbtj9p4d...CT_pre-treatment.mrml

Slice Annotations:| ‘=

L
F
B
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PET uptake findings

3D Slicer 4.4.0

Modules: . | @ Volumes = Q. P O «4d Bt~ fa Fo, 8 e
@ ® o ——— S:-139.938mm | = 1 [&

Note an intense uptake in

1) left oropharyngeal mass
involving the base of tongue
and left glossotonsillar

fossa (Axial -139 mm)

2) in left level IA/IIl lymph gy

nodes as well as a small — e
adjacent left level Ill node =

(Coronal 65 mm) 3680 |,

3) a possible small

metastasis in the left ment i

retropharyngeal region at
level of C1 (Sagittal -19 mm)

©: BPET1 (81,77,72) 1728.770978
7




«»)) PET SUV Computation

3D Slicer 4.4.0

Modules: PET Standard Uptake Value Computation | =
e [

For the purpose of this

tutorial, we have pre-

segmented the lymph
nodes uptake region
(PET1_label). In the next

section, we will compute the G ‘
SUV for this area. - S —

Select the module PET

Standard Uptake Value -
Computation in the
category Quantification in
the modules’ menu

w

3
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PET SUV Computation

® 3D Slicer 4.4.0
&a Modules: PET Standard Uptake Value Computation ¢| = PO «d 2 Bt 8w R -8
er R e S: -168.40Tmm [ 1 &

Select the module PET
Standard Uptake Value
Computation in the mputation ¢
category Quantification in .-
the modules’ menu

Cupun
Output (csv) file vl ..
Output Label — R: -40.925mm e A, 61 281mm
Output Label Value
SUV Max

SUV Mean

SUV Minimum

oo

Status: Idle
Restore Defaults| AutoRun |~ Cancel Apply
~ Data Probe: /var/folders/zw/gbtj9p4d...CT_pre-treatment.mrml

Slice Annotations: |

| Red RAS:

L PET1-label
FCT1
BPET1

-66.4, 17.8, -168.5) Axial Sp: 3.3

92,73,63)  0(0)
369, 279, 164)-393
92,73,63) 2234.197454
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PET SUV Computation

3D Slicer 4.4.0

& Modules: PET Standard Uptake Value Computation | = PO a«dd B |t~ fa o, Ml = K

Step1: Input volumes selection
Select Input PET Volume ‘PET?’
Select Input VOI Volume ‘PET1-label’

Input PET Volume PET1
Input VOI Volume PET1-label

v Output

Output (csv) file o oo | o
Output Label -y R: -40.925mm |8 A:61.281Tmm
Output Label Value
SUV Max

SUV Mean

SUV Minimum

Status: Idle
Restore Defaults| AutoRun '~ Cancel | Apply
v Data Probe: /var/folders/zw/gbtj9p4d...CT_pre-treatment.mrml

Slice Annotations: | =

L
F
B
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Step2: Path to the DICOM PET header

Click on C:/RSNA Hands-on/S401AB/RCA23 Pujol/Slicer-4.4.0-win-
amd64-RSNA

» Help & Acknowledgement

~ PET Standard Uptake Value Computation 3
Parameter set:| PET Standard Uptake Value Computation :

~ Image and Informatjon

PET DICOM volume path| | C:/RSNA Hands-On/S401AB/RCA23 Pujol/Slicer-4.4.0-win-amd64-RSNA

Input PET Volume PET1 :
Input VOI Volume PET1-label :
~ Output

Output (csv) file
Output Label
Output Label Value
SUV Max

SUV Mean

SUV Minimum

Status: Idle

Restore Defaults| AutoRun ~ Cancel | Apply

~ Data Probe: C:/Users/ADMINI~1/AppDat...CT_pre-treatment.mrml

Slice Annotations:|
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PET SUV Computation

3

i Ed View Help

ga 8 & |Modules: PET Standard Uptake Value Computation ¢ = &, EPO @& & <2 HIt-B
@ & 4

=N

» Help & Acknowledgement

~ PET Standard Uptake Value Computation
Parameter set:| PET Standard Uptake Value Computation

~ Image and Informatjon
PET DICOM volume path| | C:/RSNA Hands-On/S401AB/RCA23 Pujol/Slicer-4.4.0-wi-amd64-RSNA
Input PET Volume PET1 :

Input VOI Volume PET1-label

~ Output
Oustrit (~end) fila

Browse to the \PET1 directory located under

C:\Users\Adminstrator\Desktop
\Quantitativelmaging_Tuesday Dec2\Quantitativelmaging_Tuesday Dec2\dataset3 PETCT

Click on Choose to select the PETDICOM vqume path

OF:.]0 € @[4]&] c®0 N3



PET SUV Computation

[ ] 3D Slicer 4.4.0
s

&a |Modules: PET Standard Uptake Value Computation :| = & PO a4 Bt~ e 5o 8 e
4 S:-168.491mm

Step3: SUV Computation
Click on Apply to compute
the SUV in the segmented
region

v Output

QOutput (csv) file

Output Label 1 S R:-40.925mm |8 A 51.081mm
Output Label Value 1

SUV Max 7.53385

SUV Mean 5.01805

e T Status: Confple

[Restore Defaults| AutoRun ~ Cancel

~ Data Probe: /var/folders/zw/gbtj9p4d...CT_pre-treatment.

Slice Annotations:| i
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3D Slicer 4.4.0

- PO el Bt 8w R+ @

PET SUV Computation

SUV Computation Results:

SUVmax = 7.53385 mg/ml
SUVmean = 5.01805 mg/ml
SUVmin = 3.39015 mg/ml

v Output
Output (csv) file
Output Label 1
R:-40.925mm e AL 61.281mm
SUV Max 7.53385 p—
SUV Mean 5.01805

SUV Minimum 3.39015

Status: Completed

P7777777777777777777777774 1 >
Restore Defaults| AutoRun '~ Cancel | Apply

v Data Probe: /var/folders/zw/gbtj9p4d...CT_pre-treatment.mrml

Slice Annotations: |
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PET SUV Computation

& siicer I Edit View Help O # 7 100%BF & E Sun1053AM Q =
[ ] ® #a Add Data %80 3D Slicer 4.4.0
o, o8 & picoM ; oy pg 7
dard Uptake Value Computation + =) (48] Z. t v @ e R v A
é B Download Sample Data I P M Q‘ _ a & @ E M a

& Save %S
Recently Loaded >

» Heln & Acknowlednement

Select File> Close Scene in the main menu

PET DICOM volume path | = /Users/liye/workshop/RSNA2014/

Input PET Volume PET1

Input VOI Volume PET1-label

~ Output

Output (csv) file

Output Label 1

Output Label Value |1 g R:-40.925mm WEEee—— S A 61.281mm
SUV Max 7.53385

SUV Mean 5.01805

SUV Minimum 3.39015

Status: Completed
P7777777777777777777777773 9%
Restore Defaults|| AutoRun |~ Cancel | Apply
~ Data Probe: /var/folders/zw/gbtj9p4d...CT_pre-treatment.mrml

Slice Annotations: | i

wmr
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Loading the PETCT scene

Drag and drop the file PETCT_post-treatment.mrb located in dataset3_PETCT

T A AITTO IO DO | T L T Ol UG U U P IORG VI |~ T8 s 11 s iy A 5 St [ ST TS A s s (o o e e e

v Image and Information 7 v File Description
PET DICOM volume path #=/4 ¥ -..ging_Tuesday_Dec2/dataset3_PETCT/PET_CT_post-treatment.mrb MRB Slicer D.

Input PET Volume None
Input VOI Volume None
v Output

Output (csv) file
Output Label
Output Label Value
SUV Max

Click OK to load oo S0k xowes
the .mrb file into Slicer  w.cr secamenmm

Slice Annotations: | =
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PET uptake findings

3D Slicer 4.4.0
Ba &a Modules: . |@ Volumes = Q0 QIO @« @ v B ot~ o Fe, -ae
e =l

B spsiicer
>
» Help & Acknowledgement

Active Volume | Select a Volume
» Volume Information

~ Display
Lookup Table:

Interpolate:
Window Level editor presets:

AR
Set the opacity of the CT2 images to
0.5 in the anatomical viewers, and
use the left mouse button to adjust
the Window and Level of the
images.

;' R: 0.460mm AL 4.371mm

L
F
B
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PET uptake findings

00ae 3D Slicer 4.4.0
&a Modules: . |@ Volumes " Q0 9O e«d s Bt~ A fo -ae
B® -
B spsiicer
>
» Help & Acknowledgement <
Active Volume | Select a Volume $

» Volume Information

~ Display

Laaliin Tahla:

Observe a mild uptake in

larynx and pharynx that 1 [ £
are likely due to radiation :
effect.

R: 0.460mm e AL 4.371mm

v Data Probe: /var/folders/zw/gbtj9p4d...T_post-treatment.mrml

Slice Annotations:| ‘=

| Red RAS:(-90.6, 1.3, -169.9) Axial Sp: 3.3

L None
FCT2 (411,237, 93)-992
BPET2 (102, 59, 36) 459.332442
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PET uptake findings

°
& Modules: . |@ Volumes

3D Slicer 4.4.0

E 3DSlicer

» Help & Acknowledgement

Active Volume | Select a Volume
» Volume Information

Note that there is no
remaining uptake in the
area of the primary
tumor or nodes after
treatment —

R:-13.754mm |& e AL 16.758mm

1 @ £

v Data Probe: /var/folders/zw/gbtj9p4d...T_post-treatment.mrml

Slice Annotations:| =
| Yellow RAS:(-13.8,15.2,-109.6) Sagittal Sp: 2.3

L None
FCT2 (279, 230, 141) 24
BPET2 (69, 57, 54) 8467.81092
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‘ﬁ' Conclusion

* This tutorial has demonstrated the 3D Slicer modules for
quantitative imaging

« Continuous advances are being made in imaging
technology and post-processing software tools

* The intersection of quantitative and clinical sciences offers
great promise to help improve outcome prediction and
tumor response to therapy
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3DSlicer at RSNA 2014

®

Quantitative Imaging Reading Room, Exhibit LL-QRR3007

e Tue. Dec.2-Fri. Dec.5, 8:00-6:00

« 3D Slicer: An Open Source Platform for Segmentation, Registration,
Quantitative Imaging, and 3D Visualization of Multi-Modal Image Data.

« Sonia Pujol, PhD, Steve Pieper, PhD, Andriy Fedorov, PhD, Ron Kikinis,
MD,
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www.slicer.org

Questions and comments: Sonia Pujol, Ph.D
spujol@bwh.harvard.edu
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